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Chapter 207

Non-Unity Null Tests for
the Odds Ratio of Two
Proportions
Introduction
This module computes power and sample size for hypothesis tests of the odds ratio of two independent
proportions where the null-hypothesized value is not equal to one. The non-offset case is available in another
procedure. This procedure compares the power achieved by each of several test statistics.
The power calculations assume that independent, random samples are drawn from two populations.

Technical Details
Suppose you have two populations from which dichotomous (binary) responses will be recorded. The probability
(or risk) of obtaining the event of interest in population 1 (the treatment group) is p1 and in population 2 (the
control group) is p2 . The corresponding failure proportions are given by q1 = 1 − p1 and q2 = 1 − p2 .
An assumption is made that the responses from each group follow a binomial distribution. This means that the
event probability, pi , is the same for all subjects within the group and that the response from one subject is
independent of that of any other subject.
Random samples of m and n individuals are obtained from these two populations. The data from these samples
can be displayed in a 2-by-2 contingency table as follows
Group
Treatment
Control
Total

Success
a
b
s

Failure
c
d
f

Total
m
n
N

The following alternative notation is sometimes used.
Group
Treatment
Control
Total

Success

Failure

Total

x11
x21
m1

x12
x22
m2

n1
n2
N

The binomial proportions, p1 and p2 , are estimated from these data using the formulae

p1 =

a x11
b x
=
and p 2 = = 21
m n1
n n2
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Comparing Two Proportions
When analyzing studies such as this, you usually want to compare the two binomial probabilities, p1 and p2 . The
most direct method of comparing these quantities is to calculate their difference or their ratio. If the binomial
probability is expressed in terms of odds rather than probability, another measure is the odds ratio.
Mathematically, these comparison parameters are

Parameter

Computation

Difference

δ = p1 − p2

Risk Ratio

φ = p1 / p2

Odds Ratio

ψ=

p1 / (1 − p1 ) p1q2
=
p2 / (1 − p2 ) p2q1

The choice of which of these measures is used might seem arbitrary, but it is not. Not only will the interpretation
be different, but, for small sample sizes, the powers of tests based on different parameters will be different. The
non-null case is commonly used in equivalence and non-inferiority testing.

Odds Ratio
Chances are usually communicated as long-term proportions or probabilities. In betting, chances are often given
as odds. For example, the odds of a horse winning a race might be set at 10-to-1 or 3-to-2. Odds can easily be
translated into probability. An odds of 3-to-2 means that the event is expected to occur three out of five times.
That is, an odds of 3-to-2 (1.5) translates to a probability of winning of 0.60.
The odds of an event are calculated by dividing the event risk by the non-event risk. Thus, in our case of two
populations, the odds are

o1 =

p1
p2
and o2 =
1 − p1
1 − p2

For example, if p1 is 0.60, the odds are 0.60/0.40 = 1.5. Rather than represent the odds as a decimal amount, it is
re-scaled into whole numbers. Instead of saying the odds are 1.5-to-1, we say they are 3-to-2.
Another way to compare proportions is to compute the ratio of their odds. The odds ratio of two events is

ψ=

p / (1 − p1 ) p1q2
o1
= 1
=
o2 p2 / (1 − p2 ) p2q1

Although the odds ratio is more complicated to interpret than the risk ratio, it is often the parameter of choice.
One reason for this is the fact that the odds ratio can be accurately estimated from case-control studies, while the
risk ratio cannot. Also, the odds ratio is the basis of logistic regression (used to study the influence of risk factors).
Furthermore, the odds ratio is the natural parameter in the conditional likelihood of the two-group, binomialresponse design. Finally, when the baseline event rates are rare, the odds ratio provides a close approximation to
the risk ratio since, in this case, 1 − p1 ≈ 1 − p2 , so that

ψ=

p / (1 − p1 ) p1
o1
= 1
≈
=φ
o2 p2 / (1 − p2 ) p2
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Hypothesis Tests
Although several statistical tests are available for testing the inequality of two proportions, only a few can be
generalized to the non-null case. No single test is the champion in every situation, so one should compare the
powers of the various tests to determine which to use.

Odds Ratio

[

] [

]

The odds ratio, ψ = p1 / (1 − p1 ) / p2 / (1 − p2 ) , is sometimes used as the comparison because of its statistical
properties and because some convenient experimental designs only allow it to be estimated. Three sets of
statistical hypotheses can be formulated:
1.
2.
3.

H 0 : ψ = ψ 0 versus H1: ψ ≠ ψ 0 ; this is often called the two-tailed test.
H 0 : ψ ≤ ψ 0 versus H1: ψ > ψ 0 ; this is often called the upper-tailed test.
H 0 : ψ ≥ ψ 0 versus H1: ψ < ψ 0 ; this is often called the lower-tailed test.

Power Calculation
The power for a test statistic that is based on the normal approximation can be computed exactly using two
binomial distributions. The following steps are taken to compute the power of such a test.
1. Find the critical value (or values in the case of a two-sided test) using the standard normal distribution. The
critical value, zcritical , is that value of z that leaves exactly the target value of alpha in the appropriate tail of
the normal distribution. For example, for an upper-tailed test with a target alpha of 0.05, the critical value is
1.645.
2. Compute the value of the test statistic, zt , for every combination of x11 and x21 . Note that x11 ranges from
0 to n1 , and x21 ranges from 0 to n2 . A small value (around 0.0001) can be added to the zero cell counts to
avoid numerical problems that occur when the cell value is zero.
3. If zt > z critical , the combination is in the rejection region. Call all combinations of x11 and x21 that lead to a
rejection the set A.
4. Compute the power for given values of 𝑝𝑝1.1 (𝑝𝑝1 under the alternative) and 𝑝𝑝2 as
𝑛𝑛1 𝑥𝑥 𝑛𝑛 −𝑥𝑥
𝑛𝑛2 𝑥𝑥 𝑛𝑛 −𝑥𝑥
1 − 𝛽𝛽 = � �𝑥𝑥 � 𝑝𝑝1.111 𝑞𝑞1.11 11 �𝑥𝑥 � 𝑝𝑝2 21 𝑞𝑞2 2 21 .
11
21
𝐴𝐴

5. Compute the actual value of alpha achieved by the design by substituting 𝑝𝑝1.0 (𝑝𝑝1 under the null) for 𝑝𝑝1.1 to
obtain
𝑛𝑛1 𝑥𝑥 𝑛𝑛 −𝑥𝑥
𝑛𝑛2 𝑥𝑥 𝑛𝑛 −𝑥𝑥
𝛼𝛼 ∗ = � �𝑥𝑥 � 𝑝𝑝1.011 𝑞𝑞1.01 11 �𝑥𝑥 � 𝑝𝑝2 21 𝑞𝑞2 2 21 .
11
21
𝐴𝐴

Asymptotic Approximations
When the values of n1 and n2 are large (say over 200), these formulas often take a long time to evaluate. In this
case, a large sample approximation is used. The large sample approximation is made by replacing the values of
p1 and p 2 in the z values with the corresponding values of p1 and p2 under the alternative hypothesis and then
computing the results based on the normal distribution. Note that in large samples, the results for the odds ratio
have not (to our knowledge) been published. In this case, we substitute the calculations based on the ratio.
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Test Statistics
Several test statistics have been proposed for testing whether the difference, ratio, or odds ratio are different from
a specified value. The main difference among the several test statistics is in the formula used to compute the
standard error used in the denominator. These tests are based on the following z-test

zt =

p1 − p 2 − δ0 − c
σ

The constant, c, represents a continuity correction that is applied in some cases. When the continuity correction is
not used, c is zero. In power calculations, the values of p1 and p 2 are not known. The corresponding values of
p1 and p2 under the alternative hypothesis are reasonable substitutes.
Following is a list of the test statistics available in PASS. The availability of several test statistics begs the
question of which test statistic you should use. The answer is simple: you should use the test statistic that you will
use to analyze your data. You may choose a method because it is a standard in your industry, because it seems to
have better statistical properties, or because your statistical package calculates it. Whatever your reasons for
selecting a certain test statistic, you should use the same test statistic during power or sample calculations.

Miettinen and Nurminen’s Likelihood Score Test
Miettinen and Nurminen (1985) proposed a test statistic for testing whether the odds ratio is equal to a specified
value, ψ 0 . Because the approach they used with the difference and ratio does not easily extend to the odds ratio,
they used a score statistic approach for the odds ratio. The regular MLE’s are p1 and p 2 . The constrained MLE’s

p1 and ~
p2 . These estimates are constrained so that ψ~ = ψ 0 . A correction factor of N/(N-1) is applied to
are ~
make the variance estimate less biased. The significance level of the test statistic is based on the asymptotic
normality of the score statistic.
The formula for computing the test statistic is

( pˆ 1 − ~p1 ) − ( pˆ 2 − ~p2 )
z MNO =

~
p1q~1

~
p2 q~2

 1
1  N 
 ~ ~ + ~ ~ 

 n1 p1q1 n2 p2 q2  N − 1 

where

~
p1 =

~
p2ψ 0
− B + B 2 − 4 AC
~
p
=
p2 (ψ 0 − 1) 2
1+ ~
2A
,
,

A = n2 (ψ 0 − 1) , B = n1ψ 0 + n2 − m1 (ψ 0 − 1) , C = −m1
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Farrington and Manning’s Likelihood Score Test of the Odds Ratio
Farrington and Manning (1990) indicate that the Miettinen and Nurminen statistic may be modified by removing
the factor N/(N-1).
The formula for computing this test statistic is

( pˆ 1 − ~p1 ) − ( pˆ 2 − ~p2 )
z FMO =

~
p1q~1

~
p2 q~2

 1
1 
 ~ ~ + ~ ~ 
 n1 p1q1 n2 p2 q2 

p1 and ~
p2 , are computed as in the corresponding test of Miettinen and Nurminen (1985)
where the estimates, ~
given above.

Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains the parameters associated with this test such as the proportions, odds ratios, sample sizes,
alpha, and power.

Solve For
Solve For
This option specifies the parameter to be solved for using the other parameters. The parameters that may be
selected are Power, Sample Size, and Effect Size.
Select Power when you want to calculate the power of an experiment.
Select Sample Size when you want to calculate the sample size needed to achieve a given power and alpha level.

Power Calculation
Power Calculation Method
Select the method to be used to calculate power. When the sample sizes are reasonably large (i.e. greater than 50)
and the proportions are between 0.2 and 0.8 the two methods will give similar results. For smaller sample sizes
and more extreme proportions (less than 0.2 or greater than 0.8), the normal approximation is not as accurate so
the binomial calculations may be more appropriate.
The choices are
•

Binomial Enumeration
Power for each test is computed using binomial enumeration of all possible outcomes when N1 and N2 ≤
Maximum N1 or N2 for Binomial Enumeration (otherwise, the normal approximation is used). Binomial
enumeration of all outcomes is possible because of the discrete nature of the data.
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•

Normal Approximation
Approximate power for each test is computed using the normal approximation to the binomial distribution.

Actual alpha values are only computed when “Binomial Enumeration” is selected.

Power Calculation – Binomial Enumeration
Options
Only shown when Power Calculation Method = “Binomial Enumeration”
Maximum N1 or N2 for Binomial Enumeration
When both N1 and N2 are less than or equal to this amount, power calculations using the binomial distribution are
made. The value of the “Actual Alpha” is only calculated when binomial power calculations are made.
When either N1 or N2 is larger than this amount, the normal approximation to the binomial is used for power
calculations.
Zero Count Adjustment Method
Zero cell counts cause many calculation problems when enumerating binomial probabilities. To compensate for
this, a small value (called the “Zero Count Adjustment Value”) may be added either to all cells or to all cells with
zero counts. This option specifies which type of adjustment you want to use.
Adding a small value is controversial, but may be necessary. Some statisticians recommend adding 0.5 while
others recommend 0.25. We have found that adding values as small as 0.0001 seems to work well.
Zero Count Adjustment Value
Zero cell counts cause many calculation problems when enumerating binomial probabilities. To compensate for
this, a small value may be added either to all cells or to all zero cells. This is the amount that is added. We have
found that 0.0001 works well.
Be warned that the value of the odds ratio will be affected by the amount specified here!

Test
Alternative Hypothesis
Specify the direction of the alternative hypothesis, H1. Note that OR = O1/O2.
•

One-Sided (H1: OR < OR0)
Refers to a lower-tailed, one-sided test in which the alternative hypothesis is H1: OR < OR0.

•

One-Sided (H1: OR > OR0)
Refers to an upper-tailed, one-sided test in which the alternative hypothesis is H1: OR > OR0.

•

Two-Sided (H1: OR ≠ OR0)
Refers to a two-sided test in which the alternative hypothesis is H1: OR ≠ OR0.

For one-sided tests, the direction you select must match the values entered for OR0 and OR1. For example, if you
select H1: OR < OR0, then the value(s) for OR1 must be less than the value(s) for OR0.
Test Type
Specify which test statistic is used in searching and reporting.
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Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis,
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of
equal proportions when in fact they are different.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected. For this procedure, a type-I error occurs when you reject the null hypothesis of equal
proportions when in fact they are equal.
Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that
about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents
the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size (When Solving for Sample Size)
Group Allocation
Select the option that describes the constraints on N1 or N2 or both.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each group. Since you are solving for both
sample sizes at once, no additional sample size parameters need to be entered.

•

Enter N1, solve for N2
Select this option when you wish to fix N1 at some value (or values), and then solve only for N2. Please note
that for some values of N1, there may not be a value of N2 that is large enough to obtain the desired power.

•

Enter N2, solve for N1
Select this option when you wish to fix N2 at some value (or values), and then solve only for N1. Please note
that for some values of N2, there may not be a value of N1 that is large enough to obtain the desired power.

•

Enter R = N2/N1, solve for N1 and N2
For this choice, you set a value for the ratio of N2 to N1, and then PASS determines the needed N1 and N2,
with this ratio, to obtain the desired power. An equivalent representation of the ratio, R, is
N2 = R * N1.

•

Enter percentage in Group 1, solve for N1 and N2
For this choice, you set a value for the percentage of the total sample size that is in Group 1, and then PASS
determines the needed N1 and N2 with this percentage to obtain the desired power.
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N1 (Sample Size, Group 1)
This option is displayed if Group Allocation = “Enter N1, solve for N2”
N1 is the number of items or individuals sampled from the Group 1 population.
N1 must be ≥ 2. You can enter a single value or a series of values.
N2 (Sample Size, Group 2)
This option is displayed if Group Allocation = “Enter N2, solve for N1”
N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.
R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter R = N2/N1, solve for N1 and N2.”
R is the ratio of N2 to N1. That is,
R = N2 / N1.
Use this value to fix the ratio of N2 to N1 while solving for N1 and N2. Only sample size combinations with this
ratio are considered.
N2 is related to N1 by the formula:
N2 = [R × N1],
where the value [Y] is the next integer ≥ Y.
For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1 (e.g., N1 =
10 and N2 = 20, or N1 = 50 and N2 = 100).
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single or a series of values.
Percent in Group 1
This option is displayed only if Group Allocation = “Enter percentage in Group 1, solve for N1 and N2.”
Use this value to fix the percentage of the total sample size allocated to Group 1 while solving for N1 and N2.
Only sample size combinations with this Group 1 percentage are considered. Small variations from the specified
percentage may occur due to the discrete nature of sample sizes.
The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single or a series of values.

Sample Size (When Not Solving for Sample Size)
Group Allocation
Select the option that describes how individuals in the study will be allocated to Group 1 and to Group 2.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each group. A single per group sample
size will be entered.

•

Enter N1 and N2 individually
This choice permits you to enter different values for N1 and N2.
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•

Enter N1 and R, where N2 = R * N1
Choose this option to specify a value (or values) for N1, and obtain N2 as a ratio (multiple) of N1.

•

Enter total sample size and percentage in Group 1
Choose this option to specify a value (or values) for the total sample size (N), obtain N1 as a percentage of N,
and then N2 as N - N1.

Sample Size Per Group
This option is displayed only if Group Allocation = “Equal (N1 = N2).”
The Sample Size Per Group is the number of items or individuals sampled from each of the Group 1 and Group 2
populations. Since the sample sizes are the same in each group, this value is the value for N1, and also the value
for N2.
The Sample Size Per Group must be ≥ 2. You can enter a single value or a series of values.
N1 (Sample Size, Group 1)
This option is displayed if Group Allocation = “Enter N1 and N2 individually” or “Enter N1 and R, where N2 =
R * N1.”
N1 is the number of items or individuals sampled from the Group 1 population.
N1 must be ≥ 2. You can enter a single value or a series of values.
N2 (Sample Size, Group 2)
This option is displayed only if Group Allocation = “Enter N1 and N2 individually.”
N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.
R (Group Sample Size Ratio)
This option is displayed only if Group Allocation = “Enter N1 and R, where N2 = R * N1.”
R is the ratio of N2 to N1. That is,
R = N2/N1
Use this value to obtain N2 as a multiple (or proportion) of N1.
N2 is calculated from N1 using the formula:
N2=[R x N1],
where the value [Y] is the next integer ≥ Y.
For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1.
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single value or a series of values.
Total Sample Size (N)
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”
This is the total sample size, or the sum of the two group sample sizes. This value, along with the percentage of
the total sample size in Group 1, implicitly defines N1 and N2.
The total sample size must be greater than one, but practically, must be greater than 3, since each group sample
size needs to be at least 2.
You can enter a single value or a series of values.
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Percent in Group 1
This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”
This value fixes the percentage of the total sample size allocated to Group 1. Small variations from the specified
percentage may occur due to the discrete nature of sample sizes.
The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single value or a series of
values.

Effect Size – Odds Ratios
OR0 (Odds Ratio|H0 = O1.0/O2)
This option specifies the odds ratio between the group 1 proportion under the null hypothesis and the proportion
in group 2. This value is used with P2 to calculate the value of P1.0. The power calculations assume that P1.0 is
the value of the P1 under the null hypothesis. In this non-null case, the value of P1.0 is not equal to P2 as it is in
the null case.
You may enter a range of values such as 0.5 0.6 0.7 0.8 or 1.25 to 2.0 by 0.25.
Odds ratios must greater than zero.
OR1 (Odds Ratio|H1 = O1.1/O2)
This option specifies the odds ratio of the two proportions P1.1 and P2. This odds ratio is used with P2 to
calculate the value of P1.1. The power calculations assume that P1.1 is the actual value of the proportion in group
1, which is the experimental, or treatment, group.
You may enter a range of values such as 0.5 0.6 0.7 0.8 or 1.25 to 2.0 by 0.25. Odds ratios must greater than zero.

Effect Size – Group 2 (Reference)
P2 (Group 2 Proportion)
Specify the value of P2, the control, baseline, or standard group’s proportion. The null hypothesis is that the two
proportions differ by a specified amount. Since P2 is a proportion, these values must be between zero and one.
You may enter a range of values such as 0.1,0.2,0.3 or 0.1 to 0.9 by 0.1.

207-10
© NCSS, LLC. All Rights Reserved.

PASS Sample Size Software

NCSS.com

Non-Unity Null Tests for the Odds Ratio of Two Proportions

Example 1 – Finding Power
A study is being designed to determine the effectiveness of a new treatment. The standard treatment has a success
rate of 65%. They would like to show that the odds ratio of success rates for the new treatment to the old
treatment is at least 1.4.
The researchers plan to use the Farrington and Manning likelihood score test statistic to analyze the data that will
be (or has been) obtained. They want to study the power of the Farrington and Manning test at group sample sizes
ranging from 50 to 200 for detecting an odds ratio of 1.4 when the actual odds ratio ranges from 2 to 3. The
significance level will be 0.025.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Non-Unity Null Tests for the Odds Ratio of Two Proportions procedure window by
expanding Proportions, then Two Independent Proportions, then clicking on Test (Non-Zero Null), and then
clicking on Non-Unity Null Tests for the Odds Ratio of Two Proportions. You may then make the appropriate
entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.

Option

Value

Design Tab
Solve For ................................................ Power
Power Calculation Method ...................... Normal Approximation
Alternative Hypothesis ............................ One-Sided (H1: OR > OR0)
Test Type ................................................ Likelihood Score (Farr. & Mann.)
Alpha ....................................................... 0.025
Group Allocation ..................................... Equal (N1 = N2)
Sample Size Per Group .......................... 50 100 150 200
OR0 (Odds Ratio|H0 = O1.0/O2)............ 1.4
OR1 (Odds Ratio|H1 = O1.1/O2)............ 2 2.5 3
P2 (Group 2 Proportion) ......................... 0.65

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results ────────────────────────────────────────────────────────────
Test Statistic: Farrington & Manning Likelihood Score Test
Hypotheses: H0: OR ≤ OR0 vs. H1: OR > OR0
Power*
N1
0.12420
50
0.20182
100
0.27751
150
0.35055
200
0.24109
50
0.41585
100
0.56501
150
0.68469
200
(Report continues)

N2
50
100
150
200
50
100
150
200

N
100
200
300
400
100
200
300
400

Ref.
P2
0.6500
0.6500
0.6500
0.6500
0.6500
0.6500
0.6500
0.6500

P1|H0
P1.0
0.7222
0.7222
0.7222
0.7222
0.7222
0.7222
0.7222
0.7222

P1|H1
P1.1
0.7879
0.7879
0.7879
0.7879
0.8228
0.8228
0.8228
0.8228

OR|H0
OR0
1.400
1.400
1.400
1.400
1.400
1.400
1.400
1.400

OR|H1
OR1
2.000
2.000
2.000
2.000
2.500
2.500
2.500
2.500

Alpha
0.0250
0.0250
0.0250
0.0250
0.0250
0.0250
0.0250
0.0250

* Power was computed using the normal approximation method.
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Report Definitions
Power is the probability of rejecting a false null hypothesis.
N1 and N2 are the number of items sampled from each population.
N is the total sample size, N1 + N2.
P2 is the proportion for Group 2, which is the standard, reference, or control group.
P1 is the proportion for Group 1, which is the treatment or experimental group. P1.0 is the Group 1 proportion
under the null hypothesis. P1.1 is the proportion for Group 1 under the alternative hypothesis at which
power and sample size calculations are made.
OR0 is the odds ratio (O1/O2) under the null hypothesis. OR1 is the odds ratio under the alternative
hypothesis used for power and sample size calculations.
Alpha is the probability of rejecting a true null hypothesis.
Summary Statements ─────────────────────────────────────────────────────────
Group sample sizes of 50 in Group 1 and 50 in Group 2 achieve 12.420% power to detect an odds
ratio of 2.0000 when the null-hypothesized odds ratio is 1.4000. The Group 2 proportion is
0.6500. The Group 1 proportion is assumed to be 0.7222 under the null hypothesis and 0.7879
under the alternative hypothesis. The test statistic used is the one-sided Score test
(Farrington & Manning). The significance level of the test is 0.0250.

This report shows the values of each of the parameters, one scenario per row.

Plots Section

The values from the table are displayed in the above charts. These charts give us a quick look at the sample size
that will be required for various values of OR1.
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Example 2 – Finding the Sample Size
Continuing with the scenario given in Example 1, the researchers want to determine the sample size necessary for
each value of OR1 to achieve a power of 0.80.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Non-Unity Null Tests for the Odds Ratio of Two Proportions procedure window by
expanding Proportions, then Two Independent Proportions, then clicking on Test (Non-Zero Null), and then
clicking on Non-Unity Null Tests for the Odds Ratio of Two Proportions. You may then make the appropriate
entries as listed below, or open Example 2 by going to the File menu and choosing Open Example Template.

Option

Value

Design Tab
Solve For ................................................ Sample Size
Power Calculation Method ...................... Normal Approximation
Alternative Hypothesis ............................ One-Sided (H1: OR > OR0)
Test Type ................................................ Likelihood Score (Farr. & Mann.)
Power ...................................................... 0.80
Alpha ....................................................... 0.025
Group Allocation ..................................... Equal (N1 = N2)
OR0 (Odds Ratio|H0 = O1.0/O2)............ 1.4
OR1 (Odds Ratio|H1 = O1.1/O2)............ 2 2.5 3
P2 (Group 2 Proportion) ......................... 0.65

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results ────────────────────────────────────────────────────────────
Test Statistic: Farrington & Manning Likelihood Score Test
Hypotheses: H0: OR ≤ OR0 vs. H1: OR > OR0
Target
Power
0.80
0.80
0.80

Actual
Power*
0.80022
0.80057
0.80122

N1
645
266
167

N2
645
266
167

N
1290
532
334

Ref.
P2
0.6500
0.6500
0.6500

P1|H0
P1.0
0.7222
0.7222
0.7222

P1|H1
P1.1
0.7879
0.8228
0.8478

OR|H0
OR0
1.400
1.400
1.400

OR|H1
OR1
2.000
2.500
3.000

Alpha
0.0250
0.0250
0.0250

* Power was computed using the normal approximation method.

The required sample size will depend a great deal on the value of OR1. Any effort spent determining an accurate
value for OR1 will be worthwhile.
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Example 3 – Comparing the Power of the Two Test Statistics
Continuing with Example 2, the researchers want to determine which of the eight possible test statistics to adopt
by using the comparative reports and charts that PASS produces. They decide to compare the powers from
binomial enumeration and actual alphas for various sample sizes between 600 and 800 when OR1 is 2.0.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Non-Unity Null Tests for the Odds Ratio of Two Proportions procedure window by
expanding Proportions, then Two Independent Proportions, then clicking on Test (Non-Zero Null), and then
clicking on Non-Unity Null Tests for the Odds Ratio of Two Proportions. You may then make the appropriate
entries as listed below, or open Example 3 by going to the File menu and choosing Open Example Template.

Option

Value

Design Tab
Solve For .................................................................. Power
Power Calculation Method ........................................ Binomial Enumeration
Maximum N1 or N2 for Binomial Enumeration ......... 5000
Zero Count Adjustment Method ................................ Add to zero cells only
Zero Count Adjustment Value .................................. 0.0001
Alternative Hypothesis .............................................. One-Sided (H1: OR > OR0)
Test Type .................................................................. Likelihood Score (Farr. & Mann.)
Alpha ......................................................................... 0.025
Group Allocation ....................................................... Equal (N1 = N2)
Sample Size Per Group ............................................ 600 700 800
OR0 (Odds Ratio|H0 = O1.0/O2).............................. 1.4
OR1 (Odds Ratio|H1 = O1.1/O2).............................. 2
P2 (Group 2 Proportion) ........................................... 0.65
Reports Tab
Show Comparative Reports ...................................... Checked
Comparative Plots Tab
Show Comparative Plots .......................................... Checked
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Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results and Plots
Power Comparison of Two Different Tests ───────────────────────────────────────────
Hypotheses: H0: OR ≤ OR0 vs. H1: OR > OR0

N1/N2
600/600
700/700
800/800

P2
P1.1
0.6500 0.7879
0.6500 0.7879
0.6500 0.7879

Target
Alpha
0.0250
0.0250
0.0250

F.M.
Score
Power
0.7805
0.8404
0.8849

M.N.
Score
Power
0.7805
0.8402
0.8849

Note: Power was computed using binomial enumeration of all possible outcomes.
Actual Alpha Comparison of Two Different Tests ───────────────────────────────────────
Hypotheses: H0: OR ≤ OR0 vs. H1: OR > OR0

N1/N2
600/600
700/700
800/800

P2
P1.1
0.6500 0.7879
0.6500 0.7879
0.6500 0.7879

Target
Alpha
0.0250
0.0250
0.0250

F.M.
Score
Alpha
0.0250
0.0250
0.0249

M.N.
Score
Alpha
0.0250
0.0249
0.0249

Note: Actual alpha was computed using binomial enumeration of all possible outcomes.

Both test statistics have almost identical power and actual alpha values for all sample sizes studied.
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Example 4 – Comparing Power Calculation Methods
Continuing with Example 3, let’s see how the results compare if we were to use approximate power calculations
instead of power calculations based on binomial enumeration.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Non-Unity Null Tests for the Odds Ratio of Two Proportions procedure window by
expanding Proportions, then Two Independent Proportions, then clicking on Test (Non-Zero Null), and then
clicking on Non-Unity Null Tests for the Odds Ratio of Two Proportions. You may then make the appropriate
entries as listed below, or open Example 4 by going to the File menu and choosing Open Example Template.

Option

Value

Design Tab
Solve For ................................................ Power
Power Calculation Method ...................... Normal Approximation
Alternative Hypothesis ............................ One-Sided (H1: OR > OR0)
Test Type ................................................ Likelihood Score (Farr. & Mann.)
Alpha ....................................................... 0.025
Group Allocation ..................................... Equal (N1 = N2)
Sample Size Per Group .......................... 600 700 800
OR0 (Odds Ratio|H0 = O1.0/O2)............ 1.4
OR1 (Odds Ratio|H1 = O1.1/O2)............ 2
P2 (Group 2 Proportion) ......................... 0.65
Reports Tab
Show Power Detail Report ..................... Checked

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results and Plots
Power Detail Report ──────────────────────────────────────────────────────────
Test Statistic: Farrington & Manning Likelihood Score Test
Hypotheses: H0: OR ≤ OR0 vs. H1: OR > OR0
N1/N2
600/600
700/700
800/800

P2
0.6500
0.6500
0.6500

OR0
1.400
1.400
1.400

OR1
2.000
2.000
2.000

Normal Approximation
Power
Alpha
0.77161
0.0250
0.83097
0.0250
0.87637
0.0250

Binomial Enumeration
Power
Alpha
0.78049
0.0250
0.84041
0.0250
0.88489
0.0249

Notice that the approximate power values are very close to the binomial enumeration values for all sample sizes.

207-16
© NCSS, LLC. All Rights Reserved.

PASS Sample Size Software

NCSS.com

Non-Unity Null Tests for the Odds Ratio of Two Proportions

Example 5 – Validation of Power Calculations using Blackwelder
(1993)
We could not find a validation example for a test for the odds ratio of two proportions with a non-unity null
hypothesis. The calculations are basically the same as those for a test of the ratio of two proportions with a nonunity null hypothesis, which has been validated using Blackwelder (1993). We refer you to Example 5 of Chapter
206, “Non-Unity Null Tests for the Ratio of Two Proportions,” for a validation example.
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